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Motivation 

 

Was nichts kostet ist nichts… 

 

…sagt ein deutsches Sprichwort. Dass das nicht immer so ist, zeigt sich an der kostenlosen FEM 

Software Salome-Meca. Diese bietet eine beinahe beispiellose Möglichkeit für eine 

• komfortable (weil einfach bedienbar),  

• umfangreiche (wegen der vielen Module inkl. der Betriebsfestigkeit) und  

• sichere (auf Gund der hohen Qualitätsstandards bei deren Entwicklung)  

FEM Berechnung. Leider kennen noch viel zu wenige diese charmante Lösung.  

Gleichzeitig stelle ich aber auch fest, dass sich immer mehr Personen an die Nutzung der FEM 

wagen. Und das ist gut so! 

Dieses eBook soll Ihnen den ersten Einstieg in die FEM Berechnung so einfach wie möglich 

machen. Dazu führt Sie dieses Buch durch einen kompletten Nachweis inkl. 

• der Installation 

• dem Geometrieimport 

• einer Vernetzung 

• der Berechnung  

• der Interpretation der Simulationsergebnisse 

• und einem Festigkeitsnachweis nach der FKM Richtlinie! 

 

Ich wünsche Ihnen viel Freude und viel Spaß beim Simulieren! 

 

 

 

Stefan Einbock      Vaihingen Enz, Herbst 2019 

http://www.einbock-akademie.de/
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1 KRITIK WILLKOMMEN  
 

Dieses eBook gefällt Ihnen? Dann freue ich mich über eine Motivation für mein Tun und eine 

ehrliche Rückmeldung/einen ehrlichen Kommentar auf meiner Homepage (http://einbock-akade-

mie.de/), per Mail (kontakt@einbock-akademie.de).  

Wenn Sie dieses eBook weiterempfehlen oder weiterverteilen möchten, können Sie dies sehr 

gerne tun. Bitte teilen Sie dazu den Link auf das eBook z.B. über Facebook, Twitter oder Ihre 

Homepage.  

Haben Sie einen Fehler gefunden, der sich trotz größtmöglicher Sorgfalt eingeschlichen hat? 

Bitte schreiben Sie mir eine kurze Email mit dem Hinweis auf den Fehler an diese Adresse: kon-

takt@einbock-akademie.de. 

Möchten Sie Kritik äußern? Bitte schreiben Sie mir dazu eine Email mit dem Betreff: Rezension 

an die oben angegebene Email Adresse. Über jedes faire Feedback bin ich dankbar!  

Fallen Ihnen weitere Themen ein, die sie außerdem gerne in einer künftigen Auflage behandelt 

hätten? Da dieses Buch von Ingenieuren für Ingenieure geschrieben ist, möchte ich es gerne in 

Diskussion mit Ihnen weiterentwickeln. Bitte senden Sie einfach Ihre Themenwünsche per Email 

an mich. Ich werde diese sammeln. Evtl. werde ich diese dann in meinem Blog veröffentlichen: 

http://einbock-akademie.de/blog.  

oder in einer künftigen Auflage berücksichtigen.  

http://www.einbock-akademie.de/
http://einbock-akademie.de/
http://einbock-akademie.de/
mailto:kontakt@einbock-akademie.de
mailto:kontakt@einbock-akademie.de
mailto:kontakt@einbock-akademie.de
http://einbock-akademie.de/blog
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2 INSTALLATION SAOLME-MECA 
Jede Software beginnt mit deren Installation:  

1. Hier finden Sie den Salome-Meca Download für Windows und alle bisherigen Versionen 

von Salome-Meca für Windows. Idealerweise wählen Sie die neueste Version aus.  

https://code-aster-windows.com/download/ 

WICHTIG: NICHT Code_Aster herunterladen, denn das ist nur der Solver! 

2. Entpacken Sie die zip-Datei mit Ihrem Zip-Programm. Es öffnet sich das folgende Fenster.  

Geben Sie hier den Pfad ein, in den die Daten entpackt werden sollen.  

WICHTIG: der Pfad darf keine Sonderzeichen (z.B. ö,Ü,…) enthalten. 

 

  

http://www.einbock-akademie.de/
https://code-aster-windows.com/download/
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3. Es öffnet sich das Verzeichnis mit den folgenden Ordnern: 

 
4. Wechseln Sie in den Ordner „WORK“ 

5. Führen Sie die Datei „run_slome.bat“ aus.  

6. Geschafft! Es öffnet sich Salome_Meca: 

 

 

http://www.einbock-akademie.de/
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3 FRAGESTELLUNG 
Ein Kranhaken aus 42CrMo4 nach folgender Abbildung wird im Betrieb statisch belastet. Er 

soll mittels FEM simuliert werden.  

Der Haken ist aus 42CrMo4 gefertigt und es gelten folgende Werkstoffkennwerte. Zugfestigkeit 

Rm = 1100 MPa, Streckgrenze Re = 900 MPa, E-Modul E = 210 000 MPa, Bruchdehnung A5 > 

10 % und Einsatztemperaturen T < 100°C. 

 

 

Berechnen Sie für den Kranhaken die statische Sicherheit (den Auslastungsgrad) nach FKM-

Richtlinie für eine Hakenlast von 15 KN.  

Falls diese nicht ausreichend ist, ermitteln Sie die zulässige Hakenlast. 

Hinweise:  

• Nutzen Sie dazu die kostenlose Software easyFKM ® für den statischen Nachweis 

nach der FKM-Richtlinie. In der .zip Datei finden Sie eine Version der Software.  

• Ein CAD Modell des Kranhakens finden Sie ebenfalls in der .zip Datei 

• Falls Sie Fragen zum statischen Nachweis haben, dann ist evtl. das ebenfalls kostenlose 

PDF das Sie in der .zip Datei finden genau richtig für Sie.  

• In unserem Buch Betriebsfestigkeit mit FEM (auch in englisch erhältlich) finden Sie 

noch detailliertere Hinweise zur FEM und natürlich zu einem Betriebsfestigkeitsnach-

weis. Auch für die FKM Software easyFKM ® haben wir für den Betriebsfestigkeits-

nachweis. Fragen Sie uns, gerne senden wir Ihnen eine Testversion zu:  

kontakt@einbock-akademie.de  

 

  

2
2 8

F

F

http://www.einbock-akademie.de/
https://amtn.to/2SF8mxG
mailto:kontakt@einbock-akademie.de
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4 DIE ERSTE FEM-BERECHNUNG 
Eine FEM Berechnung gliedert sich grob in die vier Schritte:  

1) Preprozessing (also dem Aufbau des FEM Modells inkl. des Einlesens der CAD Geo-

metrie, dem Vernetzen und dem Aufbringen der Lasten) 

2) Die Berechnung / Solving (also dem Berechnen der Spannungen und Dehnungen) 

3) Postprozessing (also der Auswertung der Spannungen)  

4) Festigkeitsnachweis (also der Aussage ob das Bauteil hält, oder nicht)  

4.1 PREPROZESSING 

4.1.1 SCHRITT 1) DIE BAUTELGEOMETRIE EINLESEN 
Der erste Schritt einer FEM Berechnung besteht in der Erstellung und dem Einlesen einer Bau-

teilgeometrie.  

Für dieses Beispiel verwenden wir den Kranhaken aus der Datei: 

Kranhaken.stp 

Öffnen Sie den Geometriemodul von Salome um die CAD Geometrie zu importieren (Salome 

unterstützt die folgenden CAD Formate: STEP, IGES, BREP, STL, XAO):  

 

In einem Fenster werden Sie gefragt, ob Sie ein neues Projekt oder ein vorhandenes Projekt be-

arbeiten möchten. Wählen Sie hier den Button „New“ für neues Projekt aus.   

http://www.einbock-akademie.de/
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Jetzt können Sie über File → Import → STEP die CAD Geometrie importieren. 

 

Es öffnet sich die folgende Dialogbox, hier können Sie zu dem Ablagepfad der Datei navigieren 

und diese über OPEN öffnen.  

 

Der Kranhaken sollte jetzt im Fenster sichtbar sein.  

Mit den folgenden Tastenkombinationen können Sie die Geometrie bewegen:  

• Strg + linke Maustaste:   zoomen 

• Strg + mittlere Maustaste:  verschieben 

• Strg + rechte Maustaste:  drehen 

HINWEIS: Gegebenenfalls müssen Sie die Geometrie mit dem mittleren Mausrad noch näher 

heranzoomen.  

http://www.einbock-akademie.de/
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Sehr gut! Die CAD Geometrie ist fertig! Da der importierte Name der Geometrie (er wird im 

Obeject Browser angezeigt) mit Kranhaken.step_1 etwas sperrig ist, wollen wir diesen ändern. 

Dazu klicken wir mit einen rechten Mausklick auf den Namen und drücken Rename: 

 

Jetzt können wir den Namen ändern. Wir wählen: Kranhaken.  

 

  

http://www.einbock-akademie.de/
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Wichtig ist jetzt noch zu prüfen, ob die Geometrie die richtige Größe hat! Also zu den Einheiten 

passt, in denen wir rechnen wollen.  

Dazu wählen wir „Inspection → Dimensions → Bounding Box“: 

 

Es öffnet sich das Fenster, in dem die äußeren Abmaße des Kranhakens dargestellt sind:  

 

Wir sehen, dass die Größe in Millimetern mm angegeben ist, da die Dicke 11 beträgt (also 11 

mm). Sollte die Größe nicht passen, da z.B. das Modell in Inch oder Metern angegeben ist, können 

Sie das Modell einfach skalieren.  

Dazu gehen wir über das Menü „Operations → Transformation → Scale Transform“: 

http://www.einbock-akademie.de/
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Es öffnet sich das folgende Dialogfeld in dem wir als Skalierungsfaktor (Scale Factor) 1000 an-

geben, wenn wir von Metern in Millimeter transformieren wollen.  

 

Die Auswahl bestätigen wir mit „Apply and Close“.  

http://www.einbock-akademie.de/
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Wenn wir mit der rechten Maustaste im Obejct Browser auf den blau markierten Namen 

Scale_1 klicken, können wir unter Rename einen neuen Namen vergeben. Wir einen neuen Na-

men vergeben. Wir wählen: Kranhaken_skaliert aus.   

http://www.einbock-akademie.de/
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4.1.2 SCHRITT 2) DAS NETZ ERSTELLEN 
Um das FEM-Netz zu erstellen müssen wir in den Mesh Modul von Salome wechseln:  

 

Es öffnet sich das Mesh Modul von Salome:  

HINWEIS: evtl. müssen Sie hier ebenfalls wieder das Bauteil heranzoomen.  

 

  

http://www.einbock-akademie.de/
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Wählen Sie jetzt das Bauteil mit der linken Maustaste aus. Wenn das Bauteil ausgewählt ist, 

nimmt es eine helle graue Farbe an und im linken Menü ist das Bauteil blau markiert:  

 

Wenn die Geometrie ausgewählt ist können Sie über das Menü 

Mesh → Create Mesh 

Das Netz erstellen lassen:  

 

  

http://www.einbock-akademie.de/


Seite 18 4 Die erste FEM-Berechnung 

 
Claus von Stauffenbergstrasse 5, 71665 Vaihingen | www.einbock-akademie.de  

© EINBOCKAKADEMIE 2019 

 

Es öffnet sich das Fenster „Create Mesh“ in dem Sie den gewünschten Netzalgorithmus aus-

wählen können. Stellen Sie hier die Werte wie folgt ein:  

• Mesh type:    Any  (entweder Tetraeder oder Hexaeder) 

• Reiter 3D     (Vernetzung mit 3D Elementen) 

• Altgorithm:    NETGEN 1D-2D-3D  

• Assign a set of hypotheses:  keine Eingabe erforderlich 

WICHTIG: unter Geometry muss die Gemoetrie des Kranhakens ausgewählt sein. Falls dieses 

Feld leer ist, schließen Sie das Fenster, wählen die Geometrie mit der linken Maustaste an und 

starten die Vernetzung erneut.  

Klicken Sie mit der linken Maustaste zur Einstellung der „Hypothesis“ auf den Button  

rechts neben dem Feld „Hypothesis“. Wählen Sie „NETGEN3D“ mit der linken Maustaste aus.  

 

Es öffnet sich das Fenster „Hypothesis Construction“. Übernehmen Sie die Standardeinstellun-

gen, wählen Sie für Max Size: 2 (das ist die maximale Elementgröße) und bestätigen Sie mit 

„OK“ 

http://www.einbock-akademie.de/
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Es schließt sich das Fenster „Create Mesh“. Viel passiert ist aber nicht! Wo ist das Netz?  

Um das Netz einzufügen müssen wir im Menü „Mesh → Compute“ auswählen:  

 

Es beginnt die Netzerstellung.  

 

  

http://www.einbock-akademie.de/
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Das Ergebnis wird im Fenster „Mesh computation succed“ angezeigt. Hier sind die Elementan-

zahl, Elementart und im Fehlerfall die Fehlermeldungen eingegeben. Schließen Sie das Fenster 

mit dem Button „Close“.  

 

Jetzt wird das FEM Netz des Kranhakens dargestellt! 

 

In obiger Statistk zum Netz sehen wir, dass wir nur lineare Elemente haben. Ziel muss es sein, 

mit den quadratischen Elementen zu arbeiten. Diese sind deutlich genauer.  

http://www.einbock-akademie.de/


4 Die erste FEM-Berechnung Seite 21 

 
Claus von Stauffenbergstrasse 5, 71665 Vaihingen | www.einbock-akademie.de  

© EINBOCKAKADEMIE 2019 

 

Dazu klicken wir mit der rechten Maustaste auf das Netz (Mesh_1) im Obejct Browser. Es öff-

net sich die folgende Auswahlliste, aus der wir „Convert to / from quadratic“ wählen.  

 

Es öffnet sich das Fenster, in dem wir „convert to quadratic“ wählen und mit „Apply and 

Close“ bestätigen.  

 

Das war schon alles! Jetzt ist das Netz fertig! Weiter geht’s zum FEM Modell.   

http://www.einbock-akademie.de/
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4.1.3 SCHRITT 3) DAS FEM MODELL ERSTELLEN 
Nachdem das FEM Netz erfolgreich erstellt haben geht es nun darum die Randbedingungen zu 

definieren. In diesem Fall sind das diese drei: 

• Festlegung der Festhaltung des Hakens in seiner Öse 

• Definition der symmetrischen Randbedingung, es soll aus Gründen der Rechenzeit nur 

eine Hälfte modelliert werden.  

• Aufbringung der Last.  

Zur Festlegung der Festhaltung, Randbedingung und Last sind folgende Schritte notwendig:  

1) Erstellung von Flächen, auf welche die Festhaltung aufgebracht werden sollen 

2) Verbindung der Knoten mit den Flächen 

Außerdem sind noch folgende Schritte nötig:  

3) Zuweisung der richtigen Elemente (z.B. strukturmechanische Elemente)  

4) Material des Kranhakens spezifizieren  

5) Erstellung der Randbedingungen unter denen der Haken belastet ist 

4.1.3.1 SCHRITT 3.1) ERSTELLUNG DER FLÄCHEN 

In der Öse soll die gesamte Innenfläche festgehalten werden. Dazu müssen wir eine Fläche im 

„Geometry“ Modul erstellen: 

 

Zurück im „Geometry“ Modul, wählen wir  

zuerst den Kranhaken mit der linken Maustaste an.  

Dann wählen wir im Menü „New Entity → Group → Create Group: 

http://www.einbock-akademie.de/
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Es öffnet sich das Fenster „Create Group“. Jetzt machen wir folgendes: 

1) Wir schieben das Fenster „Create Group“ möglichst weit nach links, so dass wir im Rech-

ten Bildschirm die Baugruppe gut sehen können.  

2) Wir positionieren uns die Baugruppe bei geöffnetem Fenster „Create Group“ durch dre-

hen, bewegen und zoomen so hin, dass wir die Öse gut sehen (siehe untere Abbildung) 

3) Im Fenster „Create Group“ wählen wir oben im Teil „Shape Type“ die Fläche aus.  

4) Mit gedrückter shift Taste und linker Maustaste können mehrere Flächen gewählt werden. 

Wir wählen die beiden inneren Flächen der Öse, so dass diese weis umrandet sind.  

5) Unter „Group Name“ geben wir der Gruppe den Namen „Festhaltung-oese“ 

6) Unsere Auswahl bestätigen wir mit „Apply“ 

 

  

http://www.einbock-akademie.de/
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Das Fenster „Create Group“ bleibt geöffnet. Wir wiederholen die oben genannten Schritte und 

wählen die Flächen für die Randbedingung der Symmetrie: 

1) Wir positionieren uns die Baugruppe bei geöffnetem Fenster „Create Group“ durch dre-

hen, bewegen und zoomen so hin, dass wir die Schnittfläche des Hakens gut sehen (siehe 

untere Abbildung) 

2) Im Fenster „Create Group“ wählen wir oben im Teil „Shape Type“ die Fläche aus.  

3) Wir wählen mit der linken Maustaste die Schnittfläche aus, so dass diese weis umrandet 

ist.  

4) Unter „Group Name“ geben wir der Gruppe den Namen „Randbedingung-Symmetrie“ 

5) Unsere Auswahl bestätigen wir mit „Apply“ 

 

  

http://www.einbock-akademie.de/
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Das Fenster „Create Group“ bleibt geöffnet. Wir wiederholen die oben genannten Schritte und 

wählen die Flächen für die Randbedingung der Last: 

1) Wir positionieren uns die Baugruppe bei geöffnetem Fenster „Create Group“ durch dre-

hen, bewegen und zoomen so, dass wir die Auflage der Kraft des Hakens gut sehen. 

2) Im Fenster „Create Group“ wählen wir oben im Teil „Shape Type“ die Fläche aus.  

3) Wir wählen mit der linken Maustaste die Fläche auf die die Kraft wirkt aus, so dass diese 

weis umrandet ist.  

4) Unter „Group Name“ geben wir der Gruppe den Namen „Last“ ein. 

5) Unsere Auswahl bestätigen wir mit „Apply and Close“. 

 

Im linken Teil („Object Browser“) sehen wir unter dem Kranhaken drei weitere Geometrieen, die 

drei definierten Flächen.  

 

http://www.einbock-akademie.de/
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Jetzt wechseln wir zurück in den „Mesh“ Modul von Salome-Meca: 

 

4.1.3.2 SCHRITT 3.2) VERBINDUNG DER KNOTEN MIT DEN FLÄCHEN 

Die Auswahl der Knoten in den Flächen geschieht über die Auswahl von Element Gruppen. 

Zuerst wählen wir wieder den Kranhaken mit der linken Maustaste aus.  

WICHTIG: Achten Sie darauf, dass auch das Netz und nicht die Geometrie ausgewählt ist. Im 

„Object Browser“ (ganz links) sehen Sie, was ausgewählt wurde. Die Auswahl ist blau hinter-

legt.  

Danach wird im Menü „Mesh → Create Group“ ausgewählt.  
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Es öffnet sich das Fenster „Create Group“. In dem Fenster „Create Group“ wählen wir unter 

1) „Element Type“ „Face“ aus 

2) „Name“ den Namen „Oese“ (diesen tippen wir ein) 

3) „Group Type“ „Group in Geometry“ 

 

1) Anklicken des Buttons  rechts neben „Geometry Object“ wählen wir „Direct geo-

metry selection“: 

2) Jetzt wählen wir mit der linken Maustaste im „Object Browser“ die Fläche Festhaltung-

Oese aus.  

HINWEIS: Es kann sein, dass diese Auswahl nicht angezeigt aber durchgeführt wird!  

3) Bestätigung durch „Apply“. 
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Erstellung der Elementgruppe für die Symmetrie-Randbedingung. 

In dem Fenster „Create Group“ wählen wir unter 

1)  „Name“ den Namen „Symmetrie“ (diesen tippen wir ein) 

2) „Group Type“ „Group in Geometry“ 

3) Anklicken des Buttons  rechts neben „Geometry Object“ und wählen von „Direct 

geometry selection“: 

4) Jetzt wählen wir mit der linken Maustaste im „Object Browser“ die Fläche Randbedin-

gung-Symmetrie aus.  

HINWEIS: Es kann sein, dass diese Auswahl nicht angezeigt aber durchgeführt wird!  

5) Bestätigung durch „Apply“. 
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Erstellung der Elementgruppe für die Last Randbedingung. 

In dem Fenster „Create Group“ wählen wir unter 

1) WICHITG: Jetzt wählen wir Element Type „Node“ aus 

2)  „Name“ den Namen „Last“ (diesen tippen wir ein) 

3) „Group Type“ „Group in Geometry“ 

4) Anklicken des Buttons  rechts neben „Geometry Object“ und wählen von „Direct 

geometry selection“: 

5) Jetzt wählen wir mit der linken Maustaste im „Object Browser“ die Fläche Randbedin-

gung-Symmetrie aus.  

HINWEIS: Es kann sein, dass diese Auswahl nicht angezeigt aber durchgeführt wird!  

6) Bestätigung durch „Apply and Close“. 

 

Damit haben wir jetzt die Elemente (Knoten) die in den Flächen der Randbedingungen liegen 

den Flächen zugewiesen. Später können wir dann auf diese Knoten die gewünschten Randbe-

dingungen aufbringen.   
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4.1.3.3 SCHRITT 3.3) ZUWEISUNG DER RICHTIGEN ELEMENTE 

Zum Aufbringen der Randbedingungen wechseln wir in das Modul „AsterStudy“. Wählen Sie 

die Asterversion „stable“.  

 

Jetzt müssen wir eine „Stage“ erzeugen. Dazu klicken wir im linken Teil unter „Case View“ und 

„Data Settings“ mit der rechten Maustaste auf „CurrentCase“. Es öffnet sich das folgende Menü 

und wir wählen „Add Stage“ mit der linken Maustaste aus: 

 

HINWEIS: Jede „Stage“ steht für eine Aktion die wir in der Finite Elemente Analyse machen 

müssen.  
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Jetzt müssen wir in die Analyse ein Netz („Mesh“) einfügen und die richtigen Finiten Elemente 

wählen. Dazu wählen wir die eben erzeugte „Stage_1“ mit der linken Maustaste aus und wählen 

unter „Mesh → Read Mesh“ aus: 

 

Im neuen Bildschirm öffnet sich rechts ein Command Feld. Hier lesen wir unter „Mesh file lo-

cation“ mit der linken Maustaste unser bereits erzeugtes Netz „Mesh_1“ ein:   
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Im nächsten Schritt weisen wir Finite Elemente (z.B. Elemente für den Statischen Nachweis) zu 

indem wir unter „Model Definition → Assign finite element“ wählen: 

 

  

http://www.einbock-akademie.de/


4 Die erste FEM-Berechnung Seite 33 

 
Claus von Stauffenbergstrasse 5, 71665 Vaihingen | www.einbock-akademie.de  

© EINBOCKAKADEMIE 2019 

 

Es öffnet sich rechts ein Editierfeld „Edit command“. Hier  

• setzen wir einen Haken bei „Finite Element“ und  

• wählen rechts neben der Schaltfläche neben dem Feld mit „0 Items“ mit der linken 

Maustaste ein neues Item aus (siehe rote Markierung im unteren Bild):  

 

Jetzt klicken wir auf „Edit“ im unteren Bild:  
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In diesem Schritt wählen wir die eigentlichen Elementtypen aus. Dazu wählen wir 

• „Everywhere“ an (d.h. alle Elemente werden ausgewählt) 

• „Phenomenom: Mechanic“ 

• „Modelisation: 3D“ und  

• Bestätigen mit „OK“ 

 

Und nochmal mit „OK“ bestätigen und den Schritt abschließen:  
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4.1.3.4 SCHRITT 3.4) MATERIAL SPEZIFIZIEREN 

Für eine statische mechanische Analyse sind diese Materialien notwendig:  

• Der E-Modul 

• Die Querkontraktionszahl 

Unter „Material → Define Material“ legen wir ein neues Material fest: 

 

Um das Material festzulegen,  

• Wählen wir einen Namen im Feld „Name“: S42CrMo4, 

• setzen den Haken bei “linear isotropic“ und  

• drücken den „Edit“ Button hinter „linear isotropic“ um die Materialdaten einzugeben. 
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Wir wählen für  

HINWEIS: verwenden Sie anstelle des , (Komma) immer einen . (Punkt).  

• Young’s modulus (E-Modul): 210000  

• Poission‘s ration (Querkontratkionszahl):  0.3 

• Bestätigung mit „OK“. 

 

Und Abschließen mit „OK“. 
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Jetzt muss dieses Material noch den Finiten Elementen (dem Modell) zugewiesen werden. Dazu 

wählen wir 

„Material → Assing Material“ 

 

Jetzt wählen wir im rechen „Edit Command“  

• Den Haken bei „Model“ 

• Bei „Material assignment“ klicken wir auf „0 Items“ und dann auf 

• Edit. 
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Danach wählen wir  

• „Everywhere“ aus (alle Elemente erhalten dieses Material), 

• Unter „Material“ „0 item“ wählen wir mit der linken Maustaste unser vorher definiertes 

Material S42CrMo4 aus und  

• Bestätigen mit „OK“ 

 

 

Und schließe diesen Schritt mit „OK“ ab:  
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4.1.3.5 SCHRITT 3.5) FESTLEGUNG DER EIGENTLICHEN RANDBEDINGUNGEN 

Die Randbedingungen werden über „BC and Loads → Assign mechanical loads“ festgelegt.  

HINWEIS: BC steht für Boundary Condition (also Randbedingungen). 

 

Legen wir zuerst die Festhaltung in der Öse fest. Dazu müssen wir alle Knoten in der Fläche da-

ran hindern, sich zu bewegen. Wir fixieren also alle Knoten in alle Richtungen (Freiheitsgrade 

oder DF: Degree of Freedom). 

Dies geschieht durch das Setzen des Hakens bei „FACE_IMPO“ und Auswahl mit linker Maus-

taste von „0 Item“. 

Danach drücken wir den Button „Edit“.  
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Es wird „Group of element“ angewählt und Edit gedrückt. 

 

Jetzt können wir die gewählten Elemente in der Öse anwählen durch Setzen des Hakens bei 

„Oease“. Es wird mit „OK“ bestätigt.  
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Nun müssen den gewählten Elementen sagen, welche Freiheitsgrade eingeschränkt werden sol-

len und wie groß diese sein soll.  

• Es werden alle Freiheitsgrade (DY, DZ) in y-, und z-Richtung gewählt und als gewählte 

Verschiebung „0“ eingegeben.  

• Festlegung eines Namens im Feld „Name“: Oese 

• Bestätigung mit „OK“. 

 

Bestätigung der Festlegung dieser Randbedingung mit „Apply“: 
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Nun legen wir die symmetrische Ranbedingung in der Schnittfläche fest. Dazu müssen wir alle 

Knoten in der Fläche daran hindern, sich senkrecht zur Fläche zu bewegen. Das ist die x-Rich-

tung Wir fixieren also alle Knoten in x-Richtung (Freiheitsgrade oder DF: Degree of Freedom). 

• Auswahl mit linker Maustaste von „1 Item“ hinter „FACE_IMPO“. 

• Wir legen den Namen im Feld „Name“ fest: Symm 

• Danach drücken wir den Button „Edit“ 

 

Wir wählen „Group of element“ und drücken den Button „Edit“:  
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Jetzt wählen wir die Fläche „Symmetrie“ aus und bestätigen mit „OK“. 

 

Alle diese Elemente werden daran gehindert sich in x-Richtung zu bewegen. Dazu schränken 

wir den Freiheitsgrad „DX“ in x-Richtung ein und weisen ihm eine Verschiebung von „0“ zu 

und bestätigen mit „OK“:  
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Auch diese Wahl bestätigen wir mit „OK“:  

 

Nun legen wir die Kraft fest. Dazu müssen wir wegen der Symmetrie nur die halbe Kraft auf-

bringen (F = 15 kN ist ja die ganze Kraft. Also arbeiten wir mit F = 7,5 kN). 

Wir wählen wieder „BC and Load → Assign mechanical Load“: 
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Hier wählen wir Eine Kraft aus, die auf die Knoten wirkt.  

• Dies geschieht durch das Setzen des Hakens bei „FORCE_NODALE“ und Auswahl mit 

linker Maustaste von „0 Item“. 

• Wir legen den Namen im Feld „Name“ fest: Kraft 

• Danach drücken wir den Button „Edit“ 

 

Jetzt müssen wir festlegen, auf welche Knoten die Kraft wirken soll. Dies geschieht durch Aus-

wahl von „Group of elements“ und Drücken von „Edit“: 
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Daraufhin öffnet sich das Fenster „Edit command“. Hier wählen wir die Knoten „Last“ aus. Da-

hinter wird die Anzahl der ausgewählten Knoten angegeben. In Unserem Fall sind das 649. Die 

Auswahl wird mit „OK“ bestätigt. 

 

Da wir die Kraft von F = 7500 N gleichmäßig auf alle 649 Knoten wirken soll, müssen wir je-

dem Knoten eine Kraft von F = 7500 N / 649 = 11,56N zuweisen. Da die Kraft nur in z-Rich-

tung wirken soll, geben wir nur „FZ“ vor und legen hier den Wert von FZ = 11.56 N fest. 

(WICHITG: Wieder anstelle des Kommas , den Punkt . wählen.) 

 

Danach wieder mit OK bestätigen.  

Super! Jetzt sind alle Randbedingungen. Weiter geht’s mit der Auswahl des richtigen Solvers. 

Wir starten also in die eigentliche Berechnung….  
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4.2 DIE BERECHNUNG  
Nachdem wir jetzt das eigentliche FEM Modell bestehend aus dem Netz, den richtigen Elemen-

ten für eine strukturmechanische Berechnung, den Randbedingungen (Symmetrie, Festhaltung 

und Kraft) und dem Material haben, können wir mit der eigentlichen Berechnung beginnen.  

4.2.1 SCHRITT 4) AUSWAHL DES RICHTIGEN GLEICHUNGSLÖSERS 
Hierzu gehen wir über „Analysis → static mechanical analysis“ 

 

Im sich öffnenden „Edit command“ auf der rechten Seite  

• geben wir bei „Name“ einen neuen Namen ein: Ergebnis 

• wählen wir im Feld „At least one“ den Haken bei „Material field“ 

• und klicken mit der linken Maustaste bei „Loads“ auf „0 Items“:  
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Jetzt können wir durch den Klick mit der linken Maustaste auf den Button „Edit“ eine Last hin-

zufügen. In Summe klicken wir dreimal und fügen damit drei Lasten hinzu (für die Last, die 

Symmetrie und die Randbedingung). 

Wir klicken auf den ersten „Edit“ Button mit der linken Maustaste: 

 

Jetzt wählen wir im Menü neben „Load“ die Oese aus (unsere Festhaltung) und bestätigen mit 

„OK: 
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Diesen Schritt wiederholen wir indem wir auf den zweiten „Edit“ Button mit der linken Maus-

taste klicken:  

 

Jetzt wählen wir im Menü neben „Load“ die Symmetrie aus (unsere Schnittfläche) und bestäti-

gen mit „OK: 
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Diesen Schritt wiederholen wir indem wir auf den dritten „Edit“ Button mit der linken Maus-

taste klicken:  

 

Jetzt wählen wir im Menü neben „Load“ die Kraft aus und bestätigen mit „OK: 
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Und nochmals mit „OK“ bestätigt.  

  

4.2.2 SCHRITT 5) FESTLEGUNG DES RESULT FILES 
Jetzt, nachdem wir der Berechnung alle Randbedingungen und das FEM-Modell zugewiesen ha-

ben, müssen wir festlegen, wo die Ergebnisse gespeichert werden sollen.  

Dazu klicken wir in der obigen Menüleiste auf den Erweitern Button. Es erscheint eine weitere 

Schaltfläche mit „Outputs“. 
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Hier wählen wir „Outputs → Set output results“ 

 

Jetzt wählen wir den Speicherort des „Result files“ (die Ergebnis-Datei) aus. Die Auswahl erfolgt 

unter anklicken des Buttons mit den drei Punkten rechts neben „Result file location“: 

 

Daraufhin öffnet sich ein Fenster in dem wir den Speicherort und den Namen des Result files 

angeben können. Als Name wählen wir „Ergebnisdatei“ und schließen das Fenster mit „Speci-

hern“.  

http://www.einbock-akademie.de/


4 Die erste FEM-Berechnung Seite 53 

 
Claus von Stauffenbergstrasse 5, 71665 Vaihingen | www.einbock-akademie.de  

© EINBOCKAKADEMIE 2019 

 

 

Danach  

• setzten wir bei „Format“ (das ist das Format des Result-files) und  

• bei „Results“ (hier können wir wählen, was gespeichert werden soll) einen Haken.  

• Zusätzlich klicken wir mit der linken Maustaste auf „0 item“ hinter „Results“  

• Und schließen mit „Edit“ diesen Schritt ab.  
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Jetzt können wir unter „At least one“ einen Haken bei „Result“ setzen und mit „OK“ bestätigen.  

 

Und nochmals mit OK bestätigen.  
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Jetzt gilt es noch, festzulegen, welche Ergebnisse Salome-Meca speichern soll. Standardmäßig 

werden nur Dehnungen und Verschiebungen ausgegeben. Für einen Festigkeitsnachweis benöti-

gen wir aber Spannungen (Stresses)! 

Dazu wählen wir unter „Post Prozessing → CALC_CHAMP“ aus: 

 

Jetzt können wir den Namen festlegen: wir setzen dazu den Haken bei „reuse the input object“.  

Um die Spannungen ausgeben zu lassen setzten wir einen Haken bei „CRITERIES“:  

 

und fügen durch sechsmaliges klicken mit der linken Maustaste auf den Button hinter „0 item“ die 

Spannungen SIEQ_ELGA, SIEQ_NOEU, SIEQ_ELNO hinzu. Zusätzlich fügen wir die Dehnun-

gen EPMQ_ELGA, EPMQ_NOEU, EPMQ_ELNO ein. Darin sind alle Spannungs- und Deh-

nungsergebnisse enthalten.  

http://www.einbock-akademie.de/


Seite 56 4 Die erste FEM-Berechnung 

 
Claus von Stauffenbergstrasse 5, 71665 Vaihingen | www.einbock-akademie.de  

© EINBOCKAKADEMIE 2019 

 

 

Neben den Spannungen und Dehnungen sind wir auch noch an den Verformungen interessiert. 

Diese schalten wir durch setzen des Hakens bei „DEFORMATION“ frei und fügen durch drei-

maliges klicken mit der linken Maustaste auf den Button hinter „0 item“ die Spannungen | 

EPME_ELGA, EPME_ELNO, EPME_NOEU hinzu. 

Jetzt können wir diesen Schritt abschließen mit „OK“. 
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Danach wählen wir im Feld „Results“ den Haken bei TOUT_ORDRE“ aus und bestätigen mit 

„OK“. 

 

Perfekt! Jetzt können wir endlich den Kranhaken berechnen! 
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4.2.3 SCHRITT 6) DIE BERECHNUNG DES FEM MODELLS 
Zur Berechnung wechseln wir die View (Ansicht). Aktuell befinden wir uns in der „Case 

View“ und jetzt wechseln wir in die „History View“ durch einen Klick mit der linken Maustaste 

auf den entsprechenden Reiter ganz links:   

 

In der „History View“ klicken wir mit der linken Maustaste auf „Stage_1“ und danach auf „Run“: 

 

Jetzt startet die eigentliche Berechnung (endlich      ) 
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Geschafft! Das FEM Modell wurde erfolgreich gerechnet.  

Wir wechseln mit einem linken Mausklick zurück zur „Case View“. 
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4.3 POSTPROZESSING 
Jetzt wechseln wir ins Postprozessing indem wir in der „Case View“ wählen wir „Data Files“ 

 

4.3.1 SCHRITT 7) BETRACHTUNG DER ERGEBNISSE 
Um die Ergebnisse anzuschauen wechseln wir in „ParaVis“ indem wir mit der rechten Maustaste 

auf die Ergebnisdatei klicken.  

Jetzt öffnet sich ein Menü in dem wir mit der linken Maustaste „Open in ParaVis“ auswählen.  
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Um die Ergebnisse anzuzeigen wählen wir in „ParaVis“ in dem Dropdownmenü „Ergebnis-

SIEQ_NQEU“ (Das sind die Spannungen) aus:  

 

In diesem Dropdownmenü können wir die Darstellung ändern. Hier sollten wir immer „Surface 

with edges“ wählen: 
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Da mir persönlich die Farbskala nicht gefällt stelle ich diese noch um. Unter „Edit Color 

Map“ können wir die Farbskala ändern: 

 

Es öffnet sich unten links ein Menü zum Bearbeiten der Farbskala („Color Map“). Hier klicken 

wir mit der linken Maustaste auf „Choose preset“: 

 

Dann können wir aus verschiedenen Farbskalen wählen. Mir gefällt „Blue to Red“ am besten. 

Bestätigen mit „Apply“ und die Farbeinstellung wird direkt im Bildschirm angezeigt.  

Danach schließen wir das Fenster mit „Close“. 
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Glückwunsch! Damit haben Sie Ihre erste FEM Berechnung geschafft! 

Das Ergebnis dieser Berechnung ist:  

Bei 15 KN Hakenlast sieht der Kranhaken eine Vergleichsspannung nach von Mises  

V,Mises = 845 MPa! 

Bleibt natürlich die Frage: Wie sicher ist diese Hakenlast bei einer Berechnung nach der FKM 

und der Annahmen eines statischen Nachweises. Damit beschäftigen wir uns im nächsten Kapi-

tel. 
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5 FESTIGKEITSNACHWEIS NACH DER FKM 
RICHTLINIE  

Für den statischen Festigkeitsnachweis nach der FKM Richtlinie nutzen wir die Excel-Software 

easyFKM ®. Eine kostenlose Version für den statischen Nachweis finden Sie in der .zip Datei.  

Falls sie eine 30 tägige Testversion wollen, melden Sie sich bitte einfach bei uns, wir senden 

Ihnen gerne eine zu: kontakt@einbock-akademie.de 

 

 

Die Software ist genau so aufgebaut wie die Richtlinie. Das bedeutet, dass der Festigkeitsnach-

weis in diesen sechs Schritten erfolgt:  

1) Eingabe der Spannungskennwerte 

2) Festlegung der Werkstofffestigkeit 

3) Ermittlung der Konstruktionskennwerte (der Bauteileinflüsse) 

4) Berechnung der statischen Bauteilfestigkeit 

5) Definition der Sicherheiten 

6) Bestimmung des Auslastungsgrades.  
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5.1 SCHRITT 1) EINGABE DER SPANNUNGSKENNWERTE 
Die FKM Richtlinie benötigt die Hauptspannungen aus der FEM Rechnung. Deshalb wählen 

wir in der FEM die Spannungen  

• PRIN_1 

• PRIN_2 

• PRIN_3 

Aus. Das sind unsere Hauptspannungen 1, 2 und 3:  

 

Da wir die Innenseite des Hakens an der Stelle der höchsten Vergleichsspannung auswerten 

wollen ergeben sich hier folgende Spannungen: 

• PRIN_1 = -40 MPa 

• PRIN_2 = 0 MPa 

• PRIN_3 = 859 MPa 

Für unsere Hauptspannungen heist das:  

• 1 = 859 MPa 

• 2 = 0 MPa und  

• 3 = -40 MPa. 

Diese Spannungen geben wir jetzt bei Schritt 1 in der easyFKM Software ein. Außerdem wäh-

len wir unter  

• Werkstoff:   sonstiger Stahl 

• Spannungsart wählen:  Hauptspannungen (Volumenbauteil) 

Die Felder unter Graugussfaktor können wir ignorieren, da der Nachweis ja für einen Stahl ge-

führt werden soll.  
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Weiter zu Schritt 2.  
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5.2 SCHRITT 2) FESTLEGUNG DER WERKSTOFFFESTIGKEIT 
In diesem Schritt werden die Festigkeiten ermittelt. Dazu tragen wir folgendes ein:  

• Bauteilnormwerte aus …  Halbzeug-Normwert (Rm,N) 

• Zugfestigkeit Rm,N (Normwert)   1100 MPa  

• Fließgrenze Rp,N (Normwert)  900 MPa 

• Walzstahl?    Nein 

• Fall zur Berechnung von deff  Standard FKM  

• Werkstoff    Vergütungsstahl, vergütet DIN EN 10 083-1 

• Effektiver Durchmesser deff  22mm  

Anisotropie wird nicht berücksichtigt und die Belastungsart ist Zug/Biegezug.  

Es wird angenommen, dass der Kranhaken bei 25°C betrieben wird. Deshalb können die Tem-

peratureingaben entfallen.  

 

Springen wir weiter zu Schritt 3 den Konstruktionskennwerten.  
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5.3 SCHRITT 3) ERMITTLUNG DER KONSTRUKTIONSKENN-
WERTE 

Hier wählen wir bei  

• Austenitischem Stahl im Lösungsgeglühten Zustand? nein 

• Bruchdehnung A     10 % 

• E-Modul (nach FKM Richtlinie)    210 000 MPa 

• Ist das Bauteil randschichtgehärtet?   Nein 

• Abschätzung ert aus Härte     leer lassen, da keine Härtung 

Berechnung der plastischen Formzahl (wir lassen gezielt plastische Dehnungen zu! Und er-

schließen damit Festigkeitsreserven). 

• Liegt ein plastischer Fleck vor?    nein 

• Dominieren Biegespannungen im Nachweispunkt? ja 

• Kp (aus FEM)      - (nicht ermittelt worden) 

• Kp (analytisch)      1,5 (Biegung und Rechteck) 

• Grundbeanspruchungszustand    Biegung 

• Kt,Grundbeanspruchungszustand     - (kann nicht ermittelt werden) 

• Kp,Grundbeanspruchungszustand     - (kann nicht ermittelt werden) 

Die Hintergründe zu diesen Gleichungen und Eingaben finden Sie in dem beigefügten PDF zum 

statischen Nachweis oder in dem Buch Betriebsfestigkeit mit FEM. 

 

Erledigt. Auf geht’s zu Schritt 4 
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5.4 SCHRITT 4) BERECHNUNG DER STATISCHEN BAUTEILFES-
TIGKEIT 

Hier müssen keine Eingaben getätigt werden. Es erfolgt „nur“ die Berechnung der statischen 

Bauteilfestigkeit:  

 

Kommen wir also zu Schritt 5 den Sicherheiten. 

5.5 SCHRITT 5) DEFINITION DER SICHERHEITEN 
Hier wählen wir  

• Schadensfolge     hoch (Lebensgefahr wenn der Haken bricht) 

• Wahrscheinlichkeit der Spannung:  hoch (Die 15 kN treten sicher auf)  

• Lastsicherheit    1 

Die restliche Eingabe können wir ignorieren, da kein Gussbauteil vorliegt.  

 

Fast geschafft, nur noch ein letzter Schritt:   
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5.6 SCHRITT 6) BESTIMMUNG DES AUSLASTUNGSGRADES  
Hier sind ebenfalls keine Eingaben erforderlich.  

Es werden noch einmal die wichtigsten Kennwerte dargestellt:  

• Die Vergleichsspannung:  880 MPa 

• Die statische Bauteilfestigkeit:  1286 MPa  

• Der Gesamtsicherheitsfaktor:  1,61 

Damit berechnet die Richtlinie einen Auslastungsgrad von  

aSK = 1,1 (880 MPa / 1286 MPa *1,61). 

Das Bauteil ist also statisch nicht sicher. Da ein Auslastungsgrad von aSK = 1 maximal erreicht 

werden darf. 

 

Welche Hakenlast ist jetzt also zulässig? 

Der Auslastungsgrad von aSK = 1,1 bedeutet, dass die Belastung um 10 % zu hoch ist! Zulässig 

ist ein Wert von 1.  

Da wir ein lineares FEM Modell haben, verhalten sich Hakenlast und Spannung und damit auch 

der Auslastungsgrad proportional zueinander.  

Damit wäre eine Hakenlast von  

FZUL = 15 KN / aSK = 15kN / 1,1 = 13,5kN 

zulässig. 
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